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EXCEL FOR POWER USERS

MACROS AND MULTIPLE WORKBOOKS

1 OF 6 (1-4 RECORDING AND RUNNING MACROS)

You can automate repetitive tasks in Excel by using macros.  A macro is a series of Microsoft Excel commands and functions stored in a VBA (Visual Basic for Applications) module.  You can run a macro whenever you need to carry out a task performed by that macro.  For example, if you want to add the text "Prepared by Helen Campbell" at the end of all your new worksheets, you create a macro for this.  Before you record a macro, you should plan the steps and commands you want the macro to perform.  This is because any mistakes and corrections you make while recording a macro will be stored as steps in the macro.  The first character of a macro name must be a letter and the other characters can be letters, numbers, or underscores.  Spaces or symbols are not allowed in a macro name.  You have the option to run a macro using CTRL + <shortcut key>.  You can use an uppercase letter as a shortcut key by pressing Shift and entering a letter in the Shortcut key text box.  The shortcut key will override any default Excel shortcut keys while the workbook, which contains the macro, is open.  Excel inserts a default description for each macro, which you can change if you wish to.  When you run a macro recorded with absolute references, it will be executed in exactly the same cells as those that it was recorded in.  Macros recorded with relative references are portable throughout the workbook and will be executed starting from the active cell.  You can use both absolute and relative references within the same macro.  All workbooks have access to macros stored in your Personal Macro Workbook.  Your Personal Macro Workbook (PERSONAL.XLS) is stored in the Startup folder (\XLSTART) of Excel. If you are working on a network, your Personal Macro Workbook might not be available to others.  For this reason you should make sure that all required macros are located in each workbook.  Your Personal Macro Workbook is normally hidden so if you try to delete a macro from PERSONAL.XLS, you may be prompted to unhide the workbook before you can do so.  You can display any hidden workbook using the Unhide option in the Window menu.  Excel enables you to assign a macro to a command button, drawing object, or a graphic control on your worksheet. For example, when you click the button the macro will run automatically.
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Let's say that you want to create a macro that inserts the name and address of Award Sportswear Inc. in two cells.  You want the name to display in font size 14 in Bold and Italics.  And you want the address to display in font size 8 in Italics.  To begin recording a macro, you choose the Tools menu.  Next you select Macro - Record New Macro.  You type a name for the macro in the Macro name text box or you can accept the name suggested by Excel.  You have the option to create a shortcut key for the macro by typing a letter - in this case a - at the appropriate text box.  The drop-down list enables you to select a workbook in which you want to store the macro.  All workbooks have access to macros stored in your Personal Macro Workbook.  In this case you accept the default description and click OK to begin recording your macro.  The word "Recording" on the status bar indicates that any steps you now make will be recorded in the macro.  If you click the Relative Reference button on the Stop Recording toolbar, relative references will be recorded for any cells you select while recording the macro.  You do this because you want the macro to be executed on the active cell each time.  Having clicked the Relative Reference button, you can carry out the steps you wish to record.  First you choose the font size for the company's name - in this case you select 14.  Next you click, for example, the Italic button on the Formatting toolbar.  Then you click the Bold button on the Formatting toolbar.  You type the text that you want the macro to generate - in this case Award Sportswear Inc.  Next you select A2 before typing the company's address.  Then you press Enter.  Once you have completed the steps, you click the Stop Recording button to finish recording the macro.  The macro has now been recorded and is stored in your Personal Macro Workbook and the word "Recording" is no longer visible on the status bar.

Let's say that you want to run a recorded macro in Book 2.  Because you recorded the macro named Award with relative references, the macro will start in the active cell.  In this case the name is inserted in B3 and the address is inserted in B4.  If you had recorded the macro with absolute references, the macro would always start in cell A1 - the active cell when you began recording the macro - in the current sheet.  Let's say that you want to run a macro from the active cell A12.  To run a macro, you select Macro - Macros from the Tools menu.  Next you select the macro you want to run.  To run the macro, you click the Run button.  Alternatively, you use the shortcut keys CTRL+ a to run the macro.  The macro has now been executed - in this case relative to the chosen active cell, A12.  Let's say that you have opened a new workbook - Book 5 - and you now want to create a command button to run a macro, named Headings_short, every time it is required.  To do this, you select the Tools menu. Next you select the Customize option.  You select the Commands tab and you select Macros in the Categories list.  Then you select the Custom button.  You can also assign the macro to a custom menu item.  You drag the Custom button onto a toolbar.  Next you click the Modify selection button.  Alternatively, you right-click the toolbar button and select Assign Macro.  If needed, you can change or edit the button image at this point.  You enter the name of the macro, in this case Headings_short.  To run the macro, you select the cell where you want to place the text and you click the Command button and the macro runs.  If you do not assign a macro to the button or menu item, you will be prompted to do so when you try to use the button.
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Let's say that you want to modify a recorded macro.  The Options button allows you to change the description of the selected macro or the shortcut key assigned to it.  For example, you can change the shortcut key from "a" to "s" and click OK to confirm the change.  You can edit or write macros attached to Excel workbooks using the Visual Basic (VB) Editor.  This topic is merely an introduction to editing macros and explains only the basics of the editing process. To perform advanced editing requires proper Visual Basic programming knowledge.  Suppose that you record a macro called Months in the current workbook.  You do this by typing January in cell B3 and then adding February and March in cells C3 and D3 respectively.  You then select cell E3 before clicking the Stop Recording button.  Suppose that you wish to edit the macro so that it inserts labels for the months April, May, and June in cells B3 to D3 before selecting E3.  To edit a macro, you choose Tools - Macro - Macros.  Next you select the macro from the list in the Macro dialog box.  You click Edit to make changes to the macro selected from the list.  The Step Into button in the Macro dialog box provides a debugging facility for the selected macro.  This opens the Visual Basic Editor, which shows the VB code for the macro named Months.  You replace "January" with "April", "February" with " May", and "March" with "June".  Once you have saved the changes in the VB Editor, you close it and return to your Excel workbook by choosing File - Close and Return to Microsoft Excel.  The columns have now been renamed April, May, and June.

5 OF 6 (5-6 MULTIPLE WORKBOOKS)

Excel enables you to make use of more than one workbook or to use external references by linking multiple workbooks.  To do this, you can link cells of different workbooks or create workspace files.  Let's say that you want to insert a link from a workbook to another workbook that is located on your computer or the network. For example, an INT_ss workbook contains the target sales sheet of all wetsuits sold in USA branches during the previous three months - January, February, and March - on the server at the national office.  And you have an ny_ss workbook that contains the wetsuits target sales sheet of the New York branch.  Your goal is to use data from the national branch workbook in the regional branch workbook.  This means that whenever the records in the national branch are updated, the regional records are automatically updated.  To achieve this, you create a link between the INT_ss and the ny_ss workbooks.  Suppose that you have the nyc_ss workbook open and the INT_ss workbook set up as a second window. You select the cell that is allocated for April's wetsuit sales data - E13.  Next you click the Edit Formula button.  Alternatively, you can type =.  Then you select the Window menu.  You select INT_ss.  Next you select the cell to which you want to link.  Then you return to nyc_ss, ensure that the formula is correct, and click OK.  The target wetsuit sales figure is now recorded in the nyc_ss workbook.  Whenever you update the figure in the international office, the regional office record is updated automatically.  To test this, you enter a new figure in the linked cell.  A successful link will update the record in the regional office.
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When you open a workbook that contains links to other workbooks, Microsoft Excel prompts you to update all referenced links.  Suppose that you are currently using a workbook and you want to update a link to data on another workbook.  To do this, you select the Edit menu.  Next you select the Links option.  The Links option is unavailable if your file does not contain linked information.  In the Source file list, you can alter the source of the file by selecting the linked object and clicking Change Source.  This enables you to substitute another source file.  To open and view the source destination, you can click the Open source button.  In the Links dialog box you update links by clicking the Update Now button.  Then you click OK.  Suppose that you often work with a group of workbooks simultaneously.  To avoid having to open and arrange these workbooks each time you want to view them, you can create a workspace file.  This enables you to have, for example, a single expense file containing the expense workbooks of all employees within a particular office.  A workspace file saves information about all your open workbooks, such as where they are located and their screen positions.  The workspace file does not contain the workbooks.  This means that you have to continue to save changes to the individual workbooks.  Let's say that it's your job to monitor the traveling expenses of the different offices within the company.  For example, to determine expenses for the office 7b group with members Joe Mendez and Helen Campbell, you want to view the workbooks of these members simultaneously.  Although you can open more than one workbook without creating a workspace file, it is useful to create one when you use the same workbooks repetitively.  First you open the workbooks you want to structure as a group.  Next you size and position the workbook windows as you want them to appear the next time you use the workbooks.  You select the File menu.  Next you select the Save Workspace option.  Then you specify the location of the workspace file, enter a name for the file in the File name text box, and click Save.

END OF MACROS AND MULTIPLE WORKBOOKS

SUMMARY:

You have seen how to record, run, and edit macros and how to link multiple workbooks.  

You can record macros and then store these in your current workbook, in a new workbook, or in your Personal Macro Workbook. Macros are recorded with absolute or relative references. In Excel, you use the Visual Basic (VB) Editor to write or  edit macros.  Excel enables you to make use of more than one workbook and external references by linking multiple workbooks. To open a group of workbooks simultaneously, you create a workspace file. A workspace file saves information about all your open workbooks, such as where they are located and their screen positions.

UNIT TEST:

1. Can a number be used as the first character in a macro name?

a. Yes

b. No

2. Which of the following are allowed in a macro name after the first letter?

a. Spaces

b. Symbols

c. Underscores

d. Hyphens

e. Numbers

3. Where should you store a macro if you wish to access it from all workbooks?

a. In the current workbook

b. In a new workbook

c. In your Personal Macro Workbook

4. Which of the following statements about the Personal Macro Workbook are true?

a. Your Personal Macro Workbook is normally unhidden

b. Your Personal Macro Workbook is normally hidden

c. When you try to delete a macro from PERSONAL.XLS, you may be prompted to unhide the workbook before you can do so

d. You cannot delete a macro from PERSONAL.XLS

e. You can delete a macro from PERSONAL.XLS only in its hidden state

5. Which of the following statements about the workspace file are true?

a. A workspace file saves information about all your open workbooks, such as where they are located and their screen positions

b. The workspace file contains the workbooks

c. The workspace file does not contain the workbooks

d. With workspace files you don't have to continue to save changes you make to the individual workbooks

ANSWERS:

1. No

2. c & e*** (d)

3. c

4. b & c

5. a & c

EXCEL FOR POWER USERS

SHARING DATA

1 OF 9 (1-3 IMPORTING DATA FROM TEXT FILES)

When working in a workgroup environment, you often need to share data with others.  Sharing data requires you to import data into Excel from files created and used by other users.  In most cases you may want to be able to update - or refresh - the data in your worksheet by importing data from text files.  You can import data from text files by dragging and dropping the contents of the file into Excel.  Alternatively, you can drag and drop the text file from Explorer into a blank worksheet.  But the most effective way to import data is to use the Text Import Wizard because you can specify how the data in the text file should appear in Excel.  You can import the text file as an object that is linked to the source document.  This object is updated whenever the source document changes.  Let's say that you have a text file that contains data on sales of clothing at Award Sportswear and you want to import this data into an Excel worksheet.  Tabs delimit this data.  You drag the text file from Windows Explorer onto the taskbar and into your open Excel application.  This method works if the data in your text file is separated by tabs and not by other delimiters, such as commas or slashes.  This displays the text file in Excel.  You can then format the table and save the workbook as an Excel file.  You can view the text file in a word processor, such as Word.  To import the data from Word to Excel, you first select the data.  Then you right-click the selection and drag it onto the taskbar and into Excel.  When you release the right mouse button, a shortcut menu is displayed allowing you to

• move or copy the data

• copy the data as a document object

• link the document as an object

• create a hyperlink to the source

• create a shortcut to the source

You select the Copy here option.  And the data is copied to the worksheet.
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Let's say that you have a table of figures, indicating product sales between August 1999 and January 2000, in a text file that you want to import into an Excel file.  However, commas separate the figures.  So you choose to use the Text Import Wizard.  You select the Data menu.  Next you select the Get External Data menu option.  Then you select Import Text File.  In the Import Text File dialog box you locate the file that you want to import, select it, and click Import.  The Text Import Wizard opens and you can see that the wizard provides you with a preview of how your data will be displayed.  In the Original data type section you see that the wizard has determined that the data type in the text file is delimited.  In the Start import at row spin box you can choose the first row from which you want the data selected, in this case you want all the text - so you keep the default setting.  You ensure that Windows (ANSI) has been selected as the text file's format and then you click Next to continue.  You are required to specify the delimiters used in the text file and you can see a preview of how the data is arranged.  Excel automatically selects the Tab as the default delimiter but you can choose another - in this case the Comma checkbox.  If you choose the wrong delimiter character, the data will appear on separate rows but in a single column.  The Treat consecutive delimiters as one checkbox allows you to specify that Excel ignore cases where the data contains more than one delimiter character between data fields - for example when more than one tab separates the data.  And the Text Qualifier drop-down list allows you to select a character that qualifies as text.  When you have chosen your options, you click Next.
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You can use Microsoft Query to import data from an external data source to Excel.  Using the Query Wizard, you can import data from applications such as Access, SQL Server, or Online Analytical Processing (OLAP) Cubes.  Excel allows you to use the Query Wizard to import data from sources other than text or HTML files.  The Query Wizard requires you to install Microsoft Query and - if the data is stored anywhere other than on your own computer - to have access permissions to the data source.  Let's say that you want to import customer data from an Access database into the current worksheet.  You select the cell where you want the external data range to begin - in this case A1.  You select Data - Get External Data.  Then you select the New Database Query menu option.  The Choose Data Source dialog box enables you to specify from which database, existing queries, or OLAP cube you want to retrieve data.  The Browse button allows you to search for additional data sources or queries - such as those stored on the network.  The Options button allows you to set and display the locations for data sources - DSN files.  And the Use the … queries checkbox allows you to use the Query Wizard to import data to a worksheet.  If you deselect the Use the … queries checkbox, you will use Microsoft Query - rather than the Query Wizard - to create your queries.  To retrieve data from an Access database, you select the MS Access Database list option and you click OK.  In the Select Database dialog box you locate and select the Access database you want to query and then you click OK.  The Query Wizard connects to the data source and you are asked to choose the columns of data that you want included in your query.  Suppose that before selecting columns, you want to specify the data source features that you want available to your queries.  The Options button displays the features - such as tables and views - you can choose to display in the Available tables and columns list.  The selection you make will become the default selection for the next query you create using the same data source.  In this case you keep the default choices and you click OK.

4 OF 9 (4-5 IMPORTING DATA FROM APPLICATIONS)

You can use Microsoft Query to import data from an external data source to Excel.  Using the Query Wizard, you can import data from applications such as Access, SQL Server, or Online Analytical Processing (OLAP) Cubes.  Excel allows you to use the Query Wizard to import data from sources other than text or HTML files.  The Query Wizard requires you to install Microsoft Query and - if the data is stored anywhere other than on your own computer - to have access permissions to the data source.  Let's say that you want to import customer data from an Access database into the current worksheet.  You select the cell where you want the external data range to begin - in this case A1.  You select Data - Get External Data.  Then you select the New Database Query menu option.  The Choose Data Source dialog box enables you to specify from which database, existing queries, or OLAP cube you want to retrieve data.  The Browse button allows you to search for additional data sources or queries - such as those stored on the network.  The Options button allows you to set and display the locations for data sources - DSN files.  And the Use the … queries checkbox allows you to use the Query Wizard to import data to a worksheet.  If you deselect the Use the … queries checkbox, you will use Microsoft Query - rather than the Query Wizard - to create your queries.  To retrieve data from an Access database, you select the MS Access Database list option and you click OK.  In the Select Database dialog box you locate and select the Access database you want to query and then you click OK.  The Query Wizard connects to the data source and you are asked to choose the columns of data that you want included in your query.  Suppose that before selecting columns, you want to specify the data source features that you want available to your queries.  The Options button displays the features - such as tables and views - you can choose to display in the Available tables and columns list.  The selection you make will become the default selection for the next query you create using the same data source.  In this case you keep the default choices and you click OK.
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Suppose that you are using the Query Wizard to add columns to your query.  To add columns from the Customer table, you click the plus (+) sign to expand the list.  Then you select a column - in this case CustomerID - and you click the Preview Now button to preview the data.  To add the column to the query, you click the right-pointing arrow.  The CustomerID column is added to the Columns in your query list box.  You can move all columns out of the Columns in your query list box using the left-pointing double arrows.  And you can add all the columns in the Customer table by selecting the table name and clicking the right-pointing arrow.  When you have selected all the other columns you require, you can sort the columns using the up and down scroll buttons - in this case you move the CompanyName column down two places.  Once you have added and sorted the columns, you click the Next button.  You can filter the data to include selected parts of the data, such as specific rows that should be included, but in this case you choose not to filter the data and you click Next.  You can sort your data by clicking the Sort by down-pointing arrow and selecting a column - in this case CustomerID.  You then ensure that the customer IDs will be sorted in ascending order and you click Next.  And because you want to view the data in Excel, you ensure that the Return Data to Microsoft Excel radio button is selected.  You click the Save Query button to save the query.  When you have selected your options, you click Finish.  The Returning External Data to Microsoft Excel dialog box is displayed and you can see that you can add the data to the current worksheet, another worksheet, or a PivotTable report.  You click the Properties button to display the properties of the external data range.  In the External Data Range Properties dialog box you can see that - among other options - you can specify how often the data range is refreshed and the formatting of the data.  In this case you choose to refresh the data when the file is opened and to specify that an entire row be inserted for new data.  Then you click OK.  You click the OK button to import the data.  And the data is added to the Excel worksheet.

6 OF 9 (6-7 IMPORTING AN HTML FILE)

You can import data from a table on a web page into an Excel workbook.  The data is automatically presented as a table and you can choose whether you want the web page's formatting to apply to the Excel table.  To add data to an Excel workbook from a table on a web page, you select Data - Get External Data menu option.  To retrieve data from a web page, you select the New Web Query menu option.  And to locate the HTML file, you click the Browse Web button.  In your web browser you locate the file that contains the table of data - in this case NYC Customers.htm.  You need to have write access to the file that contains the data.  You click OK to open the file.  And the page is displayed.  You return to Excel without closing your browser and you can see that the page's address is now in the text box.  You want to import the tables only so you select the Only the tables radio button.  To retain the full formatting available in the web page, you select the Full HTML formatting radio button.  You click the Advanced button to specify the options for the web page's preformatted sections and dates.  For example, you can see that you can choose how to handle characters acting as delimiters for each column - in this case you keep the default settings and you click OK.  You can save the query by clicking the Save Query button.  This creates an IQY file that you can use for other workbooks or to share with other users - in this case you save the query as NYC Customers.iqy.  You click OK to close the New Web Query dialog box.  You select the cell for the top left-hand corner of the table - in this case A2.  You click the Properties button to specify the properties of the table.  In this case you choose to refresh the data when the file is opened and to preserve cell formatting, and then you click OK.  You click OK to create the table.  And the table is added to the workbook. 
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Let's say that you want to make changes to the table in the web page and you want to update the table in the Excel workbook.  This process is called "round-tripping".  If you are browsing the web page in Internet Explorer and you want to make changes to the table, you right-click the web page and select View Source.  You can only make changes to a web page if you have permissions to make the changes. The web page must be either on your local machine or on a server to which you have write access.  In your text editor you locate the data you want to change and you make the changes.  You then save the document as an HTML file, overwriting the original file.  You click the Refresh button to see the changes.  And the changes are reflected in the worksheet.  And you return to Excel.  You open the External Data toolbar.  The External Data toolbar allows you to change the properties for the external data range, edit the query, and refresh the data.  The Refresh Data button on the External Data toolbar refreshes a single instance of data in the spreadsheet.  You can see the changes made to the web page now reflected in the Excel document's table.  When you have numerous tables linked to different data sources, the Refresh All button allows you to refresh all the data tables in a spreadsheet at one time.  You click the Edit Query button to edit the conditions of the query.  You can change how much information is displayed and the amount of formatting.  You click the Data Range Properties button to edit the properties of the data range.  And you can specify how often the data is refreshed.

8 OF 9 (8-9 EXPORTING DATA)

You can export data in an Excel worksheet to another application, such as Microsoft Access.  This is useful when you need to convert your worksheets into databases.  To convert data in a worksheet to an Access database, you select the Data menu.  Next you select the Convert to MS Access option.  If the Convert to MS Access option is not available, you need to have Access installed as well as the Access Links add-in program. Access Links can be added by selecting Tools - Add-ins and selecting the Access Links checkbox.  The Convert to Microsoft Access dialog box is displayed and all the data in the worksheet has been selected.  You want to create a new database so you ensure the New database radio button is selected and you click OK.  Access opens over Excel.  And then the Import Spreadsheet Wizard opens displaying the data in rows and columns.  Since the first row in the worksheet does not contain column headings, you click Next to continue.  Because you are creating a new database, the only option is to store the data in a new table, so you click Next.  And then you can specify information about each field - such as the name of the field and whether the field is indexed.  You change the name of Field1 to Items by typing Items in the Field Name text box.  And you change the next column to Jan by clicking the column and typing Jan in the Field Name text box.
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When you have named all the fields, you choose whether or not to have any fields indexed.  You click Next to continue.  And you then see that you can choose to use a primary key for your table.  You can choose a column from the Choose my own primary key drop-down list.  But in this case you choose to let Access decide which column contains the primary key and you click Next to continue.  Access provides a name for the table based on the name of the worksheet from which the data is taken.  You can also see that you can have Access analyze the table and display help after the data is imported.  In this case you accept the table name and you click Finish.  You are notified that the data has been imported, so you click OK.  You see the table displayed in Access.  And you can see that a comment has been added to the worksheet informing you of the location of the database.

END OF SHARING DATA

SUMMARY:

You have seen how you import and export data.  You can import data from a text file into an Excel worksheet by dragging the text file from Windows Explorer onto the Excel button on the taskbar.  You can also choose to import the data using the  Text Import Wizard.  You can import data into Excel from other applications, such as Access, or SQL Server, as well as existing queries and Online Analytical Processing (OLAP) Cubes.  You can use the Query Wizard to retrieve data from the data source. The Query Wizard requires you to install Microsoft Query and to have permission to access the data source.  You can import data from a table on a web page into an Excel workbook. The data is automatically presented as a table and you can choose whether  you want the web page's formatting to apply to the Excel table.  You can export data from Excel workbooks to other applications, such as Microsoft Access and  SQL Server.

UNIT TEST:

1. When you drag a text file from Windows Explorer into Excel, the table is embedded in an Excel worksheet.

a. True

b. False

2. The default delimiter in the Text Import Wizard is the _____.

a. comma

b. slash

c. tab

d. ampersand

3. With the Query Wizard you can filter the data to include selected parts of the data, such as specific rows.

a. True

b. False

4. When getting data from a web page, you can only get data from one table.

a. True

b. False

5. What extension is applied to a saved query in Excel?

a. xls

b. xlt

c. iqy

d. mdb

6. The _____ button refreshes a single instance of data in the spreadsheet.

a. Refresh 

b. Updata

c. Data

d. Refresh Data

7. You can save data in a spreadsheet to an Access database by selecting the File - Save As menu option?

a. True

b. False

8. Which of the following does the Import spreadsheet wizard allow you to do?

a. Store data in a new table

b. Assign your own name to a field

c. Choose a primary key

d. Set the data type for a given field

e. Create a link to another Access database

ANSWERS:

1. False***

2. c

3. True

4. False

5. c

6. d

7. False***

8. a, b, c & d

EXCEL FOR POWER USERS

DISPLAYING AND FORMATTING DATA

1 OF 11 (1-3 CONDITIONAL FORMATS)

You use conditional formatting if you want to highlight values that meet specific criteria in your workbook.  For example, you use it to point out all totals that meet certain criteria.  You set criteria according to the cell and formula values.  You apply a cell value to set criteria that are between, above, under, or equal to a particular value.  If you select a cell value, you can still enter a formula in the text box but the formula must result in a true or false value.  When you set conditional formatting, you first select and format only one cell.  Once you've formatted one cell, you can copy the formatting to additional cells using the Format Painter button.
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Let's say that you want to have all figures above a particular value - 50,000 for example - in the Totals column printed in green.  You select the first cell to which you want to apply the conditional formatting.  Next you select Conditional Formatting from the Format menu.  When you click the Condition 1 down-pointing arrow, it enables you to select a cell value or formula - in this case you select the cell value.  Next you need to specify a criterion by clicking this down-pointing arrow.  You select the greater than value.  You type 50000 in this text box.  Next you click the Format button.  You specify the color in which you want the figures to be printed.  To apply the conditional formatting you click OK.  Since cell H2 meets the set criterion, it is now printed in green.  To apply the set formula to the rest of the cells in the Total column, you click the Format Painter button.  Next you highlight all the cells to which you want to apply the conditional formatting.  All cells in the Total column meeting the set criteria are now formatted in green.  Let's say that you want to find cells that have specific conditional formats.  To do this, you click a cell that has the conditional criteria and formats you want to locate.  First you select the Edit menu.  Next you select the Go To option.  You click the Special button.  Next you click the Conditional formats radio button and then you click OK.  Excel highlights the area that meets your criteria.
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You use Microsoft Excel's grouping and outline tools to hide columns and rows in a workbook.  Suppose that you want to hide the sales details and display only the total sales in each month.  To do this, you select the rows that you want to hide.  You select Group and Outline - Group from the Data menu.  Next you make sure that the Rows radio button is selected and you click OK.  Your row selection is now outlined.  Your first view becomes available when you click the 1 button of the outline.  The details of the sales are now hidden and only the sales and months are displayed.  You use the 2 button to display the original view of the worksheet.  To clear the outline, you select Group and Outline - Clear Outline from the Data menu.  The outline is now hidden.

4 OF 11 (4-5 SORTING DATA)

In Excel you can rearrange the rows or columns in a list by sorting. (Footnote:  In an ascending sort Excel sorts numbers from the smallest negative number to the largest positive number. In logical values, FALSE is sorted before TRUE.  All error values are equal and blank entries are always sorted last.  Text and text that includes numbers are sorted in the following order:  0123456789'-(space)!"#$%&()*,./:;?@[\]_`{|}  

Then follows +<=> ABCDEFGHIJKLMNOPQRSTUVWXYZ  In a descending sort, the sort order is reversed, except for blank entries, which are always sorted last.)  You sort the order of rows or columns in a list based on the values in the list.  You are able to rearrange rows, columns, or individual cells alphabetically, numerically, or by date using the sort order.  You can choose to rearrange a list according to a maximum of three sort keys at the same time.  When you are sorting a multilevel list the first column that you specify is identified as the first or primary key.  The second and third columns are sorted in order after the primary one.  If the format of the first row of a table is different from the others, Excel assumes that the first row contains column titles and the other rows contain data.  If your list does not contain column headings in the first row, you click the No header row radio button.  Clicking the Options button opens the Sort Options dialog box and allows you to customize your sort order.  Lists are sorted alphabetically by default.  If you need to sort months and weekdays according to their calendar order, you use the Sort Options dialog box.  You select Normal or one of the predefined day or month sort orders.  Since Excel sorts in alphanumeric order, a user who wants to sort a row or column of Days/Months will have to create a custom sort order. These custom sort orders are common sort orders that are provided for ease of use.  In this case you accept the normal sort order for the first key and specify that you do not want to make the sort key case-sensitive.  Then you click OK.  Selecting Tools - Options - Custom Lists also allows you to create your own sort order lists. For example, you can sort a column containing names in a particular order rather than alphabetically.  If your sort returns errors or if you want to undo the sort, you can return the data to its original order by selecting Edit - Undo Sort.  You can return the data to its original order after performing up to 15 other actions by using the drop-down list attached to the Undo button.
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Let's say that you discover a mistake on the cust_nyc worksheet.  The data capturer entered the invoice numbers in descending order and not in ascending order as they should have been.  As they stand, the transactions do not match their corresponding invoice numbers.  To rearrange the list to show Invoice numbers in ascending order, you can perform a simple sort based on only one sort key.  You highlight the Invoice column.  Next you click the Sort Ascending button on the Standard toolbar.  The invoice numbers are now sorted in ascending order and each number matches the correct transaction.  Suppose that you want to sort a portion of a list or a list without a header row in descending order.  To do this, you select a list range before clicking the appropriate button on the toolbar.  The portion of the list is now sorted according to the criteria you set.  Let's say that you want to perform a multiple sort that involves rearranging more than one column in the cust_nyc workbook.  You want to arrange the list in order of highest to lowest entries in the Total column and, in case of equal figures in the Total column, you want the last names to appear in alphabetical order.  To perform a multiple sort, you start by clicking the Data menu.  You choose the Sort option.  And to specify the first key sort order, you click the Sort by down-pointing arrow.  You select Total from the Sort by drop-down list.  Next you click the Descending radio button and you click OK.  The data in the Total column is now sorted from the highest to the lowest number.  Since rows 16, 17 and 18 have equal numbers, you select Last name from the second list.  You ensure that the Ascending radio button is selected and you click OK.  The data is now sorted according to your specifications

6 OF 11 (6-7 FORMS AND SUBTOTALING)

A data form provides you with an easy way to enter new records or to update existing ones.  The form can display a maximum of 32 fields at a time.  Data forms also simplify searching a list by allowing you to specify criteria such as the same last name or the same product code.  Before using a data form, you need to define the list by highlighting the list range, including the header row.  Next you select Insert - Name - Define.  Then you name the range Database and click OK.  Alternatively, you can ensure that the highlighted cell is part of a valid list.If you have highlighted a cell in a valid list but you already have a range named "Database", this named range takes precedence over the list containing the selected cell.  To invoke a data form, you select the Data menu.  Next you choose the Form option.  The title bar of the data form shows the name of the worksheet.  Each field name is listed and the contents of a particular record are shown.  This record number form indicates the number of the current record - 1 - and the total number of records in the list - 17.  To add a record to the list, you click the New button.  The form now becomes a New Record form, showing blank data fields.  Once you have entered new data, you click the Close button.  Your new record is now included in the cust_nyc worksheet.  You can use the Scroll bar in the dialog box to view individual records in the list - in this case number 7 of 18.  The Find Prev and Find Next buttons let you step through the records one-by-one.  To remove a current record, you scroll down the list and select it.  Then you click the Delete button.  A warning box is displayed, giving you the option to cancel before you delete the record permanently.  The number of records now changes from 18 to 17 indicating that the record has been deleted.  Suppose that the cust_nyc Quantity column indicates number 1 in respect of aa6 items sold, however, Invoice 680 indicates that 3 aa6 items were in fact sold.  To edit the current record, you scroll down to the particular record.  And you simply make the changes in the appropriate fields.  You cannot edit the Total in the data form as it is generated by a formula for each record.  When you edit a record using a data form, the Restore button becomes available so that you can undo your changes before you display another record.  The Restore button is not available when you delete a record.
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You use data forms to search for data in a list.  Because the current record defines the position where the search begins in the list, it is a good idea to view the first record in a list before setting up a search.  You click the Criteria button on the data form to specify the list entries that Excel should search for.  Wildcard characters such as ? and * are permitted when entering search criteria.  The Criteria form now indicates that you must enter search criteria in the fields.  You can click the Form button at any stage to redisplay the current record.  This returns you to the first record.  The search criteria that you type in the required fields are not case-sensitive.  You click the Find Next button to locate a record with an entry of Swirton-Miller in the Last name text box.  If you started your search at record 1, the first record in the list meeting the specified criterion is now shown.  You click the Find Next button again to reveal any other records meeting the same criterion.  Record 17 also contains the Last Name Swirton-Miller.  To return to the previous occurrence of Swirton-Miller, you click Find Prev.  Suppose that you've opened the Criteria dialog box again and you want to narrow your search so that it starts from the current record and records all products, labeled aa6, sold on 12/1/999.  You enter the information as shown and you click Find Next.  Record 12 of 17 meets the required criteria.  You click Criteria to return to the Criteria form.  Next you click the Clear button.  This erases the current criteria.  Cleared criteria will be redisplayed if you click Restore before viewing another record.  As you can see, the Criteria option - unlike the New Record or Record Number options - will allow you to enter a value in the Total field.  To return to your database list from the data form, you click Close.

8 OF 11 (8-9 DATA FILTERS AND VALIDATION)

The process of selecting records meeting certain criteria from a list is called filtering.  To turn on Excel's AutoFilter facility, you must first select a cell within your list and then choose Data - Filter - AutoFilter.  A down-pointing arrow is now displayed to the right of each field name.  Each drop-down list shows the field's unique entries in ascending order.  If you click a particular entry, only the records containing that entry will be displayed.  The filtering field's down-pointing arrow and the numbers of the filtered rows are now shown in blue to indicate that the list has been filtered using that field.  To view the entire list again, you select All from the drop-down list.  If you select Top 10 from a field containing numerical entries, the Top 10 AutoFilter dialog box is displayed.  Although the Top 10 option appears in every field's drop-down list, the Top 10 AutoFilter is not available in fields that contain no numerical entries.  This allows you to filter a list by the highest- or lowest-valued numbers that are selected, or alternatively, you can choose to show a certain percentage of the records in the list.  In this case, you select the top 10 items before clicking OK.  You can refine the filter by setting another criterion and clicking OK.  In this case you want the top item - the item with the highest value - to be the only item on display.  Let's say that you want to display records that meet criteria other than the exact ones listed.  To do so, you select Custom from the AutoFilter drop-down list.  The Custom AutoFilter dialog box lets you select records using criteria that do not necessarily match exact entries.  Suppose that you are interested in invoices that were made out before 11/30/99 or after 12/1/99.  To set the first filter, you select the is less than option.  Next you select the data from the list.  You click the Or radio button and select the greater than option.  Now you click OK to filter the list.  The dates in the filtered list meet the requirements you set using Custom AutoFilter.  Remember that "And" selections must meet both (or all) criteria and "Or" selections can simply meet any single criterion.
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Let's say that your branch tries to have between 10 and 20 of any item on display in stock.  To make sure that you can maintain this, you want an alert to appear on the worksheet whenever more than 10 items of the same stock have been sold.  This alert will remind those who use the worksheet that whenever they sell more than 10 of the same item, they need to order more of this particular item.  To set a data validation, you highlight the section - in this case the Quantity column - for which you want to set a message.  You select the Data menu.  Next you select Validation.  Then you click the Allow down-pointing arrow to display a set of criteria.  To specify that you want to set the data validation for numbers below 10, you start by selecting Whole number.  Next you select the less than option.  Then you specify the number 10.  First you select the Error Alert tab.  The Message Input tab enables you to insert general messages when particular cells are selected in the workbook.  You ensure that the Show error alert … entered checkbox is selected, that the Stop alert is selected, and that you've entered the message that you want to have displayed.  Then you click OK.  When you now try to enter a number above 10 in the Quantity column, the following message appears.  The validation criteria were for entries below 10 and this new entry does not meet the criteria.

10 OF 11 (10-11 QUERYING DATABASES)

Microsoft Office 2000 includes an optional feature called Microsoft Query.  If you choose to install Microsoft Query, it's easy to import data selectively from other sources on your computer.  You can even retrieve information from data sources on the Internet or your intranet directly into your current workbook.  You can also use Microsoft Query to bring data into Word documents.  Let's say that you want to set up a list of valued customers.  You have access to the workbook CUSTOMERS.XLS, containing details of all recent transactions.  From this you want to extract information about customers who have made large purchases.  You have to create and run a query that will retrieve the information you need.  First you choose Data.  Next you select the Get External Data - New Database Query option.  If you have already created a query, you can run it immediately using the Run Saved Query option.  You now choose your data source - in this case, you need to create a new data source, so you select New Data Source and click OK.  You must supply a name for your new source - let's call it, "Valued Customers".  Next you choose a database driver.  In this case you select the Excel driver.  To continue, you click Connect.  In the ODBC Microsoft Excel Setup dialog box you click Select Workbook.  You locate the Customers workbook.  Clicking OK returns you to the ODBC Microsoft Excel Setup dialog box and you click OK again.  Valued Customers is now listed as one of your data sources.  Let's say that you want to use data from the Valued Customers data source - for example the Last name, First name, and Company columns - in your current workbook and you want to sort these according to last names.  To do this, you select Data - Get External Data - New Database Query.  Next you select Valued Customers and click OK.  You specify the columns that you want displayed and you click Next.  Since you don't want to filter any rows, you click Next.  Then you specify that you want the data to be sorted by the customers' last names and you click Next.  To return the data to Excel, you click Finish.  You specify where in your current workbook you want the data to be displayed, and click OK.  Data from Valued Customers is now displayed in your current workbook.
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An important feature of Excel 2000 is that it enables you to get information from almost any data source on the Internet or your intranet.  You can bring the data you need directly into your workbook.  To do this, you select the Data menu.  To get information from the Internet, you choose Get External Data - New Web Query.  You must be connected to the Internet or to your intranet before you can run a Web query.  The New Web Query dialog box enables you to specify what data you want to retrieve from the Internet and how you want to retrieve this data.  You have to specify the location of the information by either typing the path or browsing the Web - in this type of query most users will be browsing the Web.  When browsing the Web, you specify what you're looking for, the Web browser, and then you click the Go button.  Suppose that you've browsed to the web page where the data is located - in this case this site shows earnings release dates for US companies.  This can be either an Internet or intranet page. If you are not connected to the Internet when using this option, a Dial Up Connection dialog box will appear.  Once you've located the site, you return to the New Web Query dialog box to either save or run the query.  In this case you choose to run the tables of the query in full HTML formatting.  You are asked where you wish to insert the data.  Once you've clicked the OK button, data is pulled into the current worksheet.  To automatically update information, you select the Refresh Data option from the Data menu.  Or you can use the hyperlinks to execute queries such as querying the company named Corel.  This opens the information regarding this company.  Let's say that you've saved the query, named "earningscalendar", and you now want to run it from your current workbook.  First you select Get External Data - Run Saved Query from the Data menu.  Next you locate the query and click the Get Data button.  You specify where data needs to be inserted and click OK.  This opens the earningscalendar query in Book 1.

END OF DISPLAYING AND FORMATTING DATA

SUMMARY:

You have seen how to display and format data.  You use conditional formatting if you want to highlight values that meet particular criteria in your workbook. You set criteria according to the cell or formula values.

In Excel, a series of worksheet rows that contain related data is called a list. Excel enables you to sort the order of rows or columns in a list. You can perform a single or multiple sort based on values in the list.  A data form provides you with an easy way to enter new records or to update existing ones. The form can display a maximum of 32 fields at a time. Data forms also simplify searching a list by allowing you to specify criteria such as the same last name or the same product code.  The process of selecting records meeting certain criteria from a list is called filtering. With data validation, you set a message to appear whenever particular values are entered in columns.  Microsoft Office 2000 ships with an optional feature called Microsoft Query. If you choose to install this, it's very easy to import data selectively from other sources on your computer.

UNIT TEST:

1. Which of the following statements about cell and formula values are true?

a. If you select a cell value, you can still enter a formula in the text box

b. You cannot enter a formula in a cell value

c. The formula value you set must result in a true or false value

d. The formula value you set must result in a numberical value

2. According to which of the following values do you set conditional formats?

a. Column

b. Row

c. Total

d. Cell

e. Formula

3. You can choose to rearrange a list according to a maximum of _____ sort key(s).

a. only one

b. two

c. three

d. five

e. eight

4. If the format of the first row is different from the others, Excel assumes that the first row contains column titles and the other rows data.

a. True

b. False

5. A _____ database can retrieve data from many tables at once, while a _____ database can extract information from only one table at a time.

a. flat-file

b. relational

6. An Excel list can function as a _____ database.

a. flat-file

b. relational

7. Identify the true statements about an Excel list that serves as a database.

a. Each column in the list is a record

b. Column labels are the record names

c. Each row in the list is a record

d. Each column in the list is a field

e. Column labels are the field names

8. An Excel list can contain a maximum of _____ fields and _____ records.

a. 256

b. 65,535

9. The only way of adding records to a list is by using a data form.

a. True

b. False

10. What is the maximum number of fields that can be displayed on a data form?

a. 8

b. 16

c. 32

d. 64

e. 128

11. Can you add a record to a list using a data form if you do not complete all the fields on the form?

a. Yes

b. No

12. Which of the following can you do with the Criteria option on the data form?

a. Add a record, which has criteria, to a list

b. Edit the field entries for a particular record to match certain criteria

c. Delete a record from a list that meets specific criteria

d. Find a record with field entries matching certain criteria

13. How many sort keys can you use to rearrange a list using the Sort dialog box?

a. Only one

b. Up to three

c. Up to five

d. Up to 32

14. Which of the following can you do when using Top 10 AutoFilter to filter a list based on numerical field entries?

a. Retain records with the top 10 entries in that field

b. Filter out records with the bottom 30 percent of entries in that field

c. Keep records with the bottom 50 entries in that field

d. Show only records with the top 5 entries in that field

15. Suppose that you are filtering a list based on entries in a numerical field, using Custom AutoFilter.  You wish to select records with entries in the filtering field that range between 50 and 80.  Which combination of filters would you apply to the field entries?

a. Greater than 50 and less than 80

b. Greater than 50 or less than 80

c. Less than 50 and greater than 80

d. Less than 50 or greater than 80

16. Assume that a computer has had no modules of Office 2000 added or removed since the default installation, and that the machine is connected to the Internet.  Which of the following can be done in Excel 2000 on that machine?

a. Import another spreadsheet from a folder on the same computer

b. Query a database on the same computer

c. Query an Internet web site

d. Import data created in other Office 97 applications

17. You must have a database application (such as Microsoft Access) installed in order to run a database query from Excel.

a. True

b. False

18. Suppose you wish to create a database against which you can run a query.  The data source will be built from an existing Excel workbook, and the query will be run from Excel 2000.  Which of the following drivers is needed?

a. Microsoft Access Driver

b. Microsoft dBase Driver

c. Microsoft Excel Driver

d. Microsoft FoxPro Driver

e. Microsoft Text Driver

19. Which of the following conditions must be met to download information from the Internet into an Excel 2000 workbook?

a. The computer must be connected to the Internet

b. The computer must be running Internet Explorer or some other Web browser

c. Microsoft Query must be installed

d. The information to be imported must be already contained in Excel workbook format

ANSWERS:

1. a & c***

2. d & e*** (abce)

3. c

4. True

5. 1st blank: relational, 2nd blank: flat-file

6. a

7. c, d & e

8. 1st blank: 256, 2nd blank: 65,535

9. False

10. c

11. Yes

12. c & d*** (abc)

13. b

14. a, b, c & d

15. a

16. a & d

17. False

18. c

19. a & c*** (bc)

EXCEL FOR POWER USERS

ANALYZING DATA

1 OF 13 (1-3 PIVOTTABLES)

Excel allows you to create PivotTables to display data in a way that makes it easier to analyze.  You can use PivotTables to filter data according to specific fields and so change the emphasis of a report, for example from products to customers.  In the PivotTable and PivotChart Wizard dialog box you can choose to create a PivotTable from

• an Excel list or database

• an external database

• multiple Excel worksheets

• another PivotTable in the workbook, if one exists  If you want to use an external data source, the Microsoft Query add-in must be installed on your computer.To see whether MSQuery is installed, choose Add-Ins from the Tools menu and ensure that the MS Query checkbox is selected.  Suppose you have a list of product orders that you want to rearrange so that you can see what products were sold, in what quantities, on each date.  You also want to refine the information by viewing products according to their price range.  And you want to keep track of the invoice numbers associated with each date.  To create a PivotTable, you open the workbook that contains the information you want to rearrange and you select Data - PivotTable and PivotChart Report.  In the PivotTable and PivotChart Wizard dialog box you are prompted to select a data source for your PivotTable.  Because you're creating a PivotTable based on the worksheet you have open, you keep the default report type selected and you click Next.  On the second page of the wizard you select a range of cells for the source data by

• clicking the Collapse Dialog button and selecting the range  by dragging

• clicking the Browse button and selecting another workbook  from the list provided

In this case, you selected a cell in the list before starting the PivotTable Wizard, which is sufficient for Excel to enter the range automatically.  Since the range is already selected, you click Next to continue.  You can decide whether to display the PivotTable on a new worksheet, as in this case, or at a specified location on the current worksheet.  Then you click the Layout button to specify the appearance of the PivotTable.  You can see the column headings from your data source appear as field buttons that you can drag to the blank layout diagram to construct your PivotTable.  For example, if you drag the Date button and the Invoice button to the ROW area of the layout, Excel displays the data from these columns in your source list as row headings in the resulting PivotTable.  The cell contents of any category you drag to the COLUMN area - in this case Product - will be shown as a column label in the final table.  And the contents of the field buttons you drag to the DATA area - in this case Sum of Quantity - will be summarized in the table.  If you place a category, in this case Price, in the PAGE area, it can be used later to filter the data shown in the PivotTable.  When you are satisfied with the layout you have constructed, you click OK.  To access your format and data source settings, you click Options.  In the PivotTable Options dialog box you type a name for your PivotTable, in this case New York Customers.  You can also set format options and data settings.  When you have applied all the settings you want, you click OK.  When you have provided all your settings, you click Finish to exit the wizard.  And the PivotTable appears in a new worksheet ahead of the worksheet from which the data was taken.
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On the PivotTable you can see

• the page field and the page field item

• the data field

• the column and row fields

• the data area

The data is not filtered in any way at the moment, although the Price field drop-down list is available for this purpose in the top left corner of the table.  Suppose you decide that the table will be easier to interpret if the data is filtered using the Price field.  To filter the records in the table, you click the Price down-pointing arrow to reveal all the entries from the Price column in the original list.  You then filter the data in the PivotTable by selecting one of the options from the drop-down list - in this case $37.80 - and you click OK.  You can see that there are two invoices for items worth $37.80.  To return the PivotTable to its unfiltered state, you select All from the Price drop-down list and you click OK.  To modify an existing PivotTable, you select any cell in the table.  And you select Data - PivotTable and PivotChart Report.  You can also click the PivotTable Wizard button on the PivotTable toolbar.  The PivotTable and PivotChart Wizard opens on page 3.  To access the Layout dialog box, you click Layout.  In this case, you decide to swap the positions of the Product and Invoice buttons by dragging them and dropping them in the appropriate area and you click OK.  You click Finish on the last page of the wizard.  And the PivotTable is displayed with Invoice as a column field and Product as a row field.  You can make simple changes to a PivotTable by dragging a row field to the column area or vice-versa within the worksheet.But it is easier to make changes using the wizard.  If you want to edit data in the Data area of the PivotTable, you need to change the data in the source list on the original worksheet.  You can edit data in the Row and Column areas of the PivotTable directly on the table.  But the changes you make to the source list are not automatically applied to the PivotTable.  To apply changes to the PivotTable, you select the Data menu.  Then you select Refresh Data.  And the changes you have made are reflected in the PivotTable.  You can also select the Refresh Data button on the PivotTable toolbar to refresh the data in the table. Or you can select the Refresh on open checkbox in the Options section of the PivotTable and PivotChart Wizard to refresh data every time you open the table.
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Excel allows you to apply automatic formatting options to your PivotTables so that you can adapt your PivotTables to your needs and give them a professional appearance.  The autoformat settings can produce either indented or nonindented charts.  Nonindented formats are meant for PivotTable reports that contain column fields.  Indented formats, on the other hand, change all column fields in the report to row fields, moving them to the left of existing row fields.  The PivotTable Wizard formats PivotTables with a nonindented layout by default.  Both indented and nonindented formats leave out the summary function name, so that Sum of Products becomes Products.  If you don't use one of the autoformat options in PivotTables, the summary function names are automatically displayed.  PivotTables contain their own autoformat function, which you enable through the Options dialog box of the PivotTable Wizard.  To open the PivotTable Options dialog box, you click the PivotTable button on the PivotTable toolbar and you select Table Options.  If you want to be able to apply automatic format settings to your PivotTable, you ensure that the AutoFormat table checkbox is selected in the Format options section of the PivotTable Options dialog box.  The AutoFormat table option is usually selected by default.  To apply an autoformat to your table, you click the Format Report button.  In the AutoFormat Report dialog box you select one of the indented formats - Report 1 through Report 10 - if you want to format the PivotTable like a traditional formatted database report.  And you select one of the nonindented formats - Table 1 through 10 or the PivotTable Classic option - to keep the column fields in your table.  The Table 1 through 10 formats change an indented format to a nonindented format.But the PivotTable Classic format does not change the layout of the table.  The Table 1 through 5 and Table 7 formats place a blank line after each item in the last row field and apply character and cell formats to the table.  When you have selected a format for your PivotTable - in this case the Table 2 format - you click OK.  And the new format is applied to the table.  If you want to remove an autoformat setting or manual format settings from your PivotTable, you click the Format Report button.  Then you select None in the dialog box and you click OK.  And the format settings are removed from the table.

4 OF 13 (4-5 PIVOTTABLES AND THE WEB)

Microsoft Excel enables you to make PivotTable reports available on a web page.  You can publish PivotTable reports to the Web as either noninteractive or interactive tables.  To create a noninteractive table, you set up the report and save it as an HTML file.  PivotTables support dynamic views and so they allow you to perform dynamic analysis on any data page.  This means that you can, for example, browse, sort, filter, and group data.  You need to install the Office 2000 Web Components before you can publish PivotTables on the Web.  Once you've installed the Web Components, you use your Internet Explorer web browser to view and interact with the PivotTable.
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Microsoft Excel enables you to make PivotTable reports available on a web page.  You can publish PivotTable reports to the Web as either noninteractive or interactive tables.  To create a noninteractive table, you set up the report and save it as an HTML file.  PivotTables support dynamic views and so they allow you to perform dynamic analysis on any data page.  This means that you can, for example, browse, sort, filter, and group data.  You need to install the Office 2000 Web Components before you can publish PivotTables on the Web.  Once you've installed the Web Components, you use your Internet Explorer web browser to view and interact with the PivotTable.

6 OF 13 (6-7 PIVOTCHART REPORTS)

PivotCharts combine the interactivity provided by PivotTables with the benefits of charts.  You use PivotCharts when you want to view the data in a chart in a number of different ways in order to compare trends.  PivotCharts have many of the same features as regular charts except that PivotCharts also contain fields in which items can be added, rotated, and removed to create new views of the data.  PivotCharts can only be created on chart sheets, whereas regular charts can be embedded in an existing worksheet or on a new chart sheet.  And the default chart type for a regular chart is a clustered column, while the default type for a PivotChart is a stacked column.  PivotChart reports are always associated with PivotTable reports.  And they are based on the same type of data source as PivotTables.  You can vary the type of chart used and you can apply formatting to the chart report. 
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Let's say that you want to create a PivotChart to display information about the sales of products to key customers.  To create a PivotChart, you select the Data menu.  Then you select the PivotTable and PivotChart Report menu option.  In the PivotTable and PivotChart Wizard you can specify the source of the data as well as whether you wish to create a PivotTable or a PivotChart.  Since the data for the PivotChart comes from the current worksheet, you ensure that the Microsoft Excel … database radio button is selected.  You then select the PivotChart (with PivotTable) radio button.  And you click Next.  In step two of the PivotTable and PivotChart Wizard, you specify the range that contains the data for the chart.  If the data comes from another workbook, you can click the Browse button to locate it.  In this case the range is automatically selected.  And then you click Next.  In step three you determine where you want the PivotTable displayed and the layout options for the PivotChart.  In this case you choose to place the PivotTable on a new worksheet.  To specify a custom layout of the PivotChart, you click the Layout button.  Once you have added and arranged the categories for the PivotTable, you click OK.  To set advanced formatting, layout, and external data options for the PivotTable, you click Options.  You click Finish to complete the wizard.  The PivotChart is created on a new worksheet called Chart1 and the PivotTable toolbar is displayed.  And the accompanying PivotTable is created on a worksheet called Sheet1.

8 OF 13 (8-10 GOAL SEEK AND SOLVER)

You can use the following tools in Excel to perform simple forecasting in your worksheet:

• Goal Seek 

• Solver

Using the Goal Seek feature you can calculate the values you need to reach a particular result by varying the value of one cell.  Excel uses the known data to perform calculations instantaneously saving you from performing the same calculations many times to provide the solution.  The Goal Seek feature allows you to generate values based on a single cell.  Let's say you want to find out how much you would have to charge Hannah Button per unit of mex002 in order to keep her total cost for the product down to $450.  On the Product Sales worksheet you select Goal Seek from the Tools menu.  You specify the target cell in the Set cell text box.  You type a value in the To value text box - in this case 450.  Then you specify the target cell in the By changing cell text box and you click OK.  You can see the proposed change on the Goal Seek Status dialog box and the effect on the price per unit.  Since you don't want to accept these changes to your sales sheet you click Cancel.
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With the Solver add-in you can calculate the values you need to reach a particular result by varying the value of one or more cells.  If the Solver isn't available, you need to add it by selecting Add-Ins from the Tools menu. Then you select Solver Add-In from the list and click OK.  You can also define restraints that Solver must meet when generating an optimum solution.  You enter the cell reference that contains the formula you want to use in the Set Target Cell text box of the Solver Parameters dialog box.  You can set the value of the target cell.  In the By Changing Cells text box you enter the reference for each adjustable cell.  If you want Solver to propose the adjustable cells based on the target cell, you click Guess.  To create the constraints that you want the Solver to meet, you click the Add button.  You specify a cell or range of cells in the Cell Reference text box where you want to constrain the values.  You specify the type of restriction you want on the contents of Cell Reference box by selecting from the list.  Then you enter the constraint in the Constraint text box and click OK to return to the Solver Parameters dialog box without adding another constraint.  You can change or delete existing restraints by using the Change and Delete buttons.  You click the Options button to open the Solver Options dialog box.  In the Solver Options dialog box you can set the mathematical interpretations that Solver uses to define the means of searching for the optimal solution and the precision of the result.  You can use the Save Model button to select an area to which you want to save the problem model based on the active cell.  By clicking the Load Model button you can display the reference for the model you want to load.  When you have set your options to your requirements you click OK to return to the Solver Parameters dialog box.
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Suppose you want to use the Solver to find out how to maximize your commission based on the current commission rate on the Commissions Analysis worksheet.  You want to find out how many more of each product you will have to sell in order to increase your commission to $7000.  On the Commissions Analysis worksheet you select Solver from the Tools menu.  You specify the target cell in the Set Target Cell text box.  You select the Value of radio button and type a value - in this case 7000 - in the text box.  Then you specify the target cells in the By Changing Cells text box.  And you click the Solve button.  You can see the results Solver has provided on the worksheet.  In this case, you choose to keep the Solver solution.  And you choose to have an Answer report drawn up by selecting Answer from the Reports list and clicking OK.  The worksheet keeps the Solver solutions.  And you can see that the Answer Report 1 worksheet has been created in the workbook.

11 OF 13 (11-13 SCENARIOS)

A scenario is a named set of variable values that Excel can substitute for other values to forecast the outcome of a worksheet model.  You can apply up to 32 variables simultaneously in a scenario.  You create and save different groups of values on a worksheet as your scenarios.  And when you apply those different scenarios you can view and compare the various outcomes.  Before creating a scenario you need to name all the cells that contain

• variable values you wish to change

• formulas dependent on the changing variables

Scenarios are commonly used to provide best-case or worst-case predictions.  For example, you can create a worst sales scenario with a lower projected growth rate than an expected growth scenario.  And by merging scenarios you can compare your projections with those made by others.  
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Let's say that you are working on a sales budget and you want to view the effects of different sales on sales commissions.  To define a scenario, you select the Tools menu.  Then you select the Scenarios menu option.  In the Scenario Manager dialog box you can see that no scenarios currently exist.  To add a scenario, you click the Add button.  In the Add Scenario dialog box you type a descriptive name for the scenario in the Scenario name text box - in this case Best Product Sales.  And in the Changing cells text box you enter the cell references of cells containing the values you want to change.  By default the current username and the date are displayed in the Comment field and you can add, delete, or modify information here to provide a description of the scenario.  The Prevent changes checkbox allows you to protect the current scenario from being modified.  Protection will remain inactive, even if the Prevent changes checkbox is selected, unless your worksheet is protected. To do this, you choose Tools - Protection - Protect Sheet. You must clear the Prevent changes checkbox before you can modify or delete the scenario.  And the Hide checkbox allows you to hide the scenario from the list of scenarios in the Scenario Manager dialog box.  You click OK to create the scenario.  The Scenario Values dialog box then opens and you can see the names and values of the changing cells displayed.  You accept the default values since this is the first scenario for the worksheet.  You click the Add button to create another scenario.  You name the scenario - in this case Worst Product Sales - and select the changing cells.  You provide a description and then you click OK to create the scenario.  In the Scenario Values dialog box you enter new values for the changing cells and then you click OK.  You can now see that both scenarios are added to the Scenario Manager.  To display the results of a scenario, you first select a scenario - in this case Worst Product Sales.  You click the Show button to display the worst case figures for the sales of the catalog.  And you can see the results displayed on the worksheet.  To delete a scenario, you select the scenario and you click Delete.  To change the properties of a scenario, you select the scenario and you click Edit.

13 OF 13

You can merge scenarios from other worksheets in a workbook, or from sheets in other workbooks, with the scenarios saved on the present worksheet.  For example, you may have saved estimates of variables made by different salespeople as scenarios in separate worksheets or workbooks.  You then want to combine their scenarios with your own.  Let's say that you want to make predictions for the sales of the Award Sportswear items.  And you ask three other salespeople to save their own estimates of the variables as scenarios, based on cells B5 to K5 of separate worksheets, in another workbook called Predict.xls.  To combine the scenarios in Predict.xls with those in the present worksheet, you open both workbooks.  Then you select Tools - Scenarios.  In the Scenario Manager dialog box you click the Merge button.  In the Merge Scenarios dialog box you can see that you can merge scenarios from different workbooks as well as worksheets.  In this case you select Predict.xls from the Book drop-down list.  You select the worksheet on which the scenarios are found - in this case Commissions Analysis - and you click OK.  The scenarios from the first worksheet in Predict.xls are now displayed in the list of scenarios for the present worksheet.  And you select a scenario and click Show to view an imported scenario.  You click the Summary button in the Scenario Manager dialog box to create a summary sheet of the scenarios in the active worksheet.  In the Scenario Summary dialog box you see that you can choose to display the summary in a summary report or a PivotTable.  In this case you choose to create a scenario summary in cell B16 and then you click OK.  The summary is displayed on a new worksheet called Scenario Summary.  Rows in the sheet show you the names of the changing and result cells.  The Current Values column shows you the values of the changing cells at the time you created the summary report.  The other columns display the values of the variables and outcomes for each named scenario.

END OF ANALYZING DATA

SUMMARY:

You have seen how to analyze data  in Excel.  

Excel allows you to create PivotTables to display data in a way that makes it easier to analyze. You can use PivotTables to filter data according to specific fields and so change the emphasis of a report, for example from products to customers.  You can use Excel documents or external databases as data sources for PivotTables. You can determine row and column headings in the table and you can determine which data is reflected in the table. You can also refresh the information in a PivotTable from its data source.  You can use autoformat options to change the layout of the data so that it is displayed as an indented report or an unindented table.  Microsoft Excel enables you to make PivotTable reports available on a web page. You can publish PivotTable reports on the Web as either interactive or noninteractive tables.  PivotCharts combine the interactivity provided by PivotTables with the benefits of charts. You use PivotCharts when you want to view the data in a chart in a number of different ways in order to compare trends.  PivotCharts differ from regular charts. PivotCharts are, by default, created on chart sheets, whereas regular charts can be embedded in an existing worksheet or on a new chart sheet. And the default chart type for a regular chart is a clustered column while the default type for a PivotChart is a  stacked column.  Excel provides a number of features that you can use to perform simple forecasting and what-if analysis on data in a worksheet. You can use the Goal Seek feature to generate values based on a single cell. The Solver feature can be used to generate values using a single cell or a range of cells.  You can save different sets of variable values on a worksheet as scenarios. You add, modify, and delete scenarios using the Scenario Manager. It also allows you to view the outcome of a scenario, merge scenarios from several worksheets or workbooks onto a single worksheet, and to create a summary report of variable values (changing cells) and outcomes (result cells) for all the scenarios on  a worksheet.

UNIT TEST:

1. Which of the following are true of creating PivotTables?

a. You can use an external database as a data source

b. You can use an existing Excel sheet as a data source

c. You can select a range of cells from which to gather data before you create the table

d. You can enter the data directly in the table

e. You can construct the layout of the table yourself

2. Which of the following are true of editing a PivotTable?

a. Once information is recorded in the table, it cannot be changed

b. You can rearrange the column and row headings in the table

c. You can filter data records according to one of the fields in the table

d. You can apply an autoformat feature that indents the table

3. You can format PivotTables using the same autoformat settings that you use in other Excel sheets.

a. True

b. False

4. You need to install the Office 2000 Web Components before you can run the PivotTable list component for Web pages.

a. True

b. False

5. Which of the following statements about interactive tables and PivotTables are true?

a. PivotTables supports dynamic views, and so they allow you to perform dynamic analysis on any data page

b. Dynamic analysis includes browsing, sorting, filtering, and grouping of data

c. Dynamic analysis excludes filtering but includes grouping of data

d. Dynamic analysis excludes filtering and grouping of data

6. The default chart type for a regular chart is a _____ column, while the default type for a PivotChart is a _____ column.

a. stacked

b. clustered

7. PivotCharts are based on the same type of data source as PivotTables.

a. True

b. False

8. The _____ feature can be used to find a particular result by varying the value of one cell.  The _____ feature can be used to find a particular result by varying the value of one or more cells.

a. Goal Seek

b. Solver

9. Which of the following are characteristics of the Solver feature?

a. It is an Add-In

b. It can guess the adjustable cells

c. It can be used to perform scientific calculations

d. It can be used to vary multiple cell values to find an optimum value

10. What is the maximum number of scenarios that can be saved to one worksheet?

a. 6

b. 16

c. 24

d. 32

e. 40

11. Which of the following must be done before creating a scenario?

a. Any formulas must be removed

b. All cells that contain variable values must be named

c. All cells containing formulas that depend on the variable values must be named

d. The worksheet must be protected

12. If you hide a scenario, it will not be listed in the Scenario Manager.

ANSWERS:

1. a, b, c & e*** (ad)

2. b, c & d

3. False***

4. True

5. a & b

6. 1st blank: clustered, 2nd blank: stacked

7. True

8. 1st blank: Goal Seek, 2nd blank: Solver

9. a, b & d

10. d. 32***

11. b & c

12. True

END OF EXCEL FOR POWER USERS

COURSE TEST:

1. Can a number be used as the first character in a macro name?

a. Yes

b. No

2. Which of the following statements about the Personal Macro Workbook are true?

a. Your Personal Macro Workbook is normally unhidden

b. Your Personal Macro Workbook is normally hidden

c. When you try to delete a macro from PERSONAL.XLS, you may be prompted to unhide the workbook before you can do so

d. You cannot delete a macro from PERSONAL.XLS

e. You can delete a macro from PERSONAL.XLS only in its hidden state

3. Which of the following statements about the workspace file are true?

a. A workspace file saves information about all your open workbooks, such as where they are located and their screen positions

b. The workspace file contains the workbooks

c. The workspace file does not contain the workbooks

d. With workspace files you don't have to continue to save changes you make to the individual workbooks

4. The default delimiter in the Text Import Wizard is the _____.

a. comma

b. slash

c. tab

d. ampersand

5. With the Query Wizard you can filter the data to include selected parts of the data, such as specific rows.

a. True

b. False

6. The _____ button refreshes a single instance of data in the spreadsheet.

a. Refresh

b. Update

c. Data

d. Refresh Data

7. You can save data in a spreadsheet to an Access database by selecting the File - Save As option?

a. True

b. False

8. According to which of the following values do you set conditional formats?

a. Column

b. Row

c. Total

d. Cell

e. Formula

9. You can choose to rearrange a list according to a maximum of _____ sort key(s).

a. only one

b. two

c. three

d. five

e. eight

10. An Excel list can function as a _____ database.

a. flat-file

b. relational

11. What is the maximum number of fields that can be displayed on a data form?

a. 8

b. 16

c. 32

d. 64

e. 128

12. Identify the true statements about an Excel list that serves as a database.

a. Each column in the list is a record

b. Column labels are the record names

c. Each row in the list is a record

d. Each column in the list is a field

e. Column labels are the field names

13. Can you add a record to a list using a data form if you do not complete all the fields on the form?

a. Yes

b. No

14. Which of the following can you do when using Top 10 AutoFilter to filter a list based on numerical field entries?

a. Retain records with the top 10 entries in that field

b. Filter out records with the bottom 30 percent of entries in that field

c. Keep records with the bottom 50 entries in that field

d. Show only records with the top 5 entries in that field

15. Which of the following conditions must be met to download information from the Internet into an Excel 2000 workbook?

a. The computer must be connected to the Internet

b. The computer must be running Internet Explorer or some other Web browser

c. Microsoft Query must be installed

d. The information to be imported must be already contained in Excel workbook format

16. Suppose you wish to create a database against which you can run a query.  The data source will be built from an existing Excel workbook, and the query will be run from Excel 2000.  Which of the following drivers is needed?

a. Microsoft Access Driver

b. Microsoft dBase Driver

c. Microsoft Excel Driver

d. Microsoft FoxPro Driver

e. Microsoft Text Driver

17. Which of the following are true of editing a PivotTable?

a. Once information is recorded in the table, it cannot be changed

b. You can rearrange the column and row headings in the table

c. You can filter data records according to one of the fields in the table

d. You can apply an autoformat feature that indents the table

18. Which of the following statements about interactive tables and PivotTables are true?

a. PivotTables supports dynamic views, and so they allow you to perform dynamic analysis on any data page

b. Dynamic analysis includes browsing, sorting, filtering, and grouping of data

c. Dynamic analysis excludes filtering but includes grouping of data

d. Dynamic analysis excludes filtering and grouping of data

19. PivotCharts are based on the same type of data source as PivotTables.

a. True

b. False

20. Which of the following are characteristics of the Solver feature?

a. It is an Add-In

b. It can guess the adjustable cells

c. It can be used to perform scientific calculations

d. It can be used to vary multiple cell values to find an optimum value

21. If you hide a scenario, it will not be listed in the Scenario Manager.

a. True

b. False

ANSWERS:

1. No

2. b & c

3. a & c

4. c

5. True

6. d

7. False

8. d & e

9. c

10. a

11. c

12. c, d & e

13. Yes

14. a, b, c & d

15. a & c

16. c

17. b, c & d

18. a & b

19. True

20. a, b & d

21. True

